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Preface
Welcome to the SANPoint Control QuickStart 4.0 documentation set. The manuals and 
online help included with SANPoint Control QuickStart will show you how you can use 
the product to view, monitor, and manage your SAN.

The information in this Preface helps you find what you need in the product 
documentation and tells you how to get help when you need it.

This section includes the following topics:

“Overview of SANPoint Control QuickStart 4.0” on page xiv

“Features in the SANPoint Control Product Family” on page xv

“Upgrading from SANPoint Control QuickStart” on page xvi

“What’s In This Manual?” on page xvii

“Catalog of Product Manuals” on page xviii

“Related Resources” on page xix

“Conventions” on page xx

“Getting Help” on page xxii

“Understanding How to Troubleshoot SANPoint Control QuickStart” on page xxiii

“Contacting VERITAS” on page xxiv
xiii



Overview of SANPoint Control QuickStart 4.0
Overview of SANPoint Control QuickStart 4.0
SANPoint Control QuickStart provides automatic, accurate discovery and visualization of 
SAN devices. For discovered devices, SANPoint Control QuickStart provides detailed 
attributes and connectivity information, thus eliminating the need for manually tracking 
SAN assets.

SANPoint Control QuickStart is a VERITAS Enterprise Administrator (VEA) extension. Its 
graphical user interface displays within VEA and includes a graphical Topology Map that 
exposes the interrelationships between your SAN devices. SANPoint Control QuickStart 
provides the broad view of the entire storage network that you require while at the same 
time giving you the ability to drill down to specific information like data paths and 
resource relationships.

For a full description of the product and its major components, see “The SANPoint 
Control QuickStart Solution” on page 5.
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Features in the SANPoint Control Product Family
Features in the SANPoint Control Product Family
The following table provides a high-level summary of the features available in SANPoint 
Control QuickStart and its parent product, SANPoint Control.

Comparison of SANPoint Control Product Family Features

Task QuickStart Full Product

Discover and visualize SAN devices and meta-objects, such as fabrics 
and virtual fabrics

View graphical representation of SAN topology

Create groups to meet quality-of-service requirements

View and export inventory reports

Create device enclosures and hosts for partially-discovered objects

Launch VERITAS Volume Manager in-context from within Console

Launch other VERITAS and supported third-party applications 
in-context from within Console

 

Issue commands using the command-line interface

Control access to SAN resources through zone management

Create policies to monitor and report on SAN performance and 
utilization

Use LUN security to manage hosts’ access to LUNs within arrays

Manage arrays, including binding and masking LUNs

Manage fabrics and virtual fabrics

Perform trace routes to identify potential bottlenecks that prevent 
optimal SAN performance

Create customized attributes and wire connection information

Analyze storage consumption to discern storage trends and needs
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Upgrading from SANPoint Control QuickStart
Upgrading from SANPoint Control QuickStart
If you would like to upgrade from SANPoint Control QuickStart to its parent product, 
which contains additional features for managing and monitoring your SAN, contact your 
VERITAS sales representative.
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What’s In This Manual?
What’s In This Manual?
The SANPoint Control QuickStart Overview Guide introduces new users to the product and 
contains step-by-step instructions for using functions in the VERITAS Enterprise 
Administrator (VEA) Console.

This manual is organized as follows:

Chapter 1, “Introducing SANPoint Control QuickStart,” introduces the reader to SAN 
technology and the functions of SANPoint Control QuickStart.

Chapter 2, “Visualizing Objects on the SAN,” describes how to use the VERITAS 
Enterprise Administrator (VEA) Console to view objects on the SAN.

Chapter 3, “Creating and Modifying SAN Objects,” describes how to create and update 
enclosure, host, and device objects to help you monitor the SAN, and also describes using 
the VEA Console to manage Volume Manager disk volumes.

Chapter 4, “Controlling Access to Resources,” describes how to use groups and zones to 
maintain a quality of storage service for SAN-attached servers.

Chapter 5, “Displaying Reports about SAN Objects,” describes how to display up-to-date 
inventory data about objects on the SAN, using reports that are included with the 
SANPoint Control QuickStart product.

Appendix A, “Troubleshooting,” describes some common problems and contains 
information for diagnosing and solving them.

“Glossary” contains definitions for specialized terms used in SANPoint Control 
QuickStart.
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Catalog of Product Manuals
Catalog of Product Manuals
Portable Document Format (PDF) versions of SANPoint Control QuickStart manuals are 
installed by default in /opt/VRTSspqdc.

The following manuals ship with SANPoint Control QuickStart.

Manuals in the SANPoint Control QuickStart Documentation Set

Manual Abbreviated Title Filename

SANPoint Control QuickStart Installation and 
Configuration Guide

Install spcqs_install_icg.pdf

SANPoint Control QuickStart Overview Guide Overview spcqs_overview.pdf

SANPoint Control QuickStart Release Notes RelNotes spcqs_notes.pdf

VERITAS SANPoint Control QuickStart 4.0 
Hardware and Software Compatibility List

HCL spcqs_suptmx.pdf
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Related Resources
Related Resources
In addition to the documentation included with SANPoint Control QuickStart, the 
following documentation provides information about Storage Foundation and the 
VERITAS Enterprise Administrator (VEA) Console:

◆ Storage Solutions Installation Guide—provides important information about how to 
license, install, and get support for Storage Foundation products . You should read 
this guide before you install SANPoint Control QuickStart. The document is available 
in print and in PDF format (storage_solutions_ig.pdf) at the top level of the 
VERITAS Storage Solutions software disc 2.

◆ VERITAS Enterprise Administrator (VEA) Console online help—provides basic 
information about how to use the VEA Console.

◆ VERITAS Volume Manager online help—provides information about how to use 
VERITAS Volume Manager to manage volumes, disks, and disk groups.

◆ VERITAS File System online help—provides information about how to use VERITAS 
File System to perform basic file system operations, such as adding a file system to a 
volume or mounting a file system.

◆ Storage Solutions documentation disc—a disc that enables you to search across all 
Storage Foundation product documentation. For more information on how to use the 
searchable documentation disc, see the Storage Solutions Installation Guide.
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Conventions
Conventions
The following conventions apply throughout the documentation set.

Screen Shots

The majority of screen shots in the manuals and help were taken on Windows systems. 
Unless otherwise noted, the application and its GUI are the same across platforms. For 
cases where the application or GUI is different on UNIX, a UNIX screen shot has been 
included as well.

Typographical Conventions

Here are the typographical conventions used throughout the manuals:

You should use the appropriate conventions for your platform. For example, when 
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX. 
Significant differences between the platforms are noted in the text.

Tips, notes, and cautions are used to emphasize information. The following samples 
describe when each is used.

Tip Used for nice-to-know information, like a shortcut.

Conventions 

Convention Description

GUI Font Used to depict graphical user interface (GUI) objects, such as fields, 
listboxes, menu commands, and so on. For example: Enter your 
password in the Password field.

Italics Used for placeholder text, book titles, new terms, or emphasis. Replace 
placeholder text with your specific text. For example: Replace filename 
with the name of your file. Do not use file names that contain spaces.

Code Used to show what commands you need to type, to identify pathnames 
where files are located, and to distinguish system or application text that 
is displayed to you or that is part of a code example.

Key+Key Used to show that you must hold down the first key while pressing the 
second key. For example: Ctrl+S means hold down the Ctrl key while 
you press S.
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Conventions
Note Used for important information that you should know, but that shouldn’t cause any 
damage to your data or your system if you choose to ignore it.

Caution Used for information that will prevent a problem. Ignore a caution at your own 
risk.
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Getting Help
Getting Help
You can access SANPoint Control QuickStart online help from within the VERITAS 
Enterprise Administrator (VEA) Console. Within the VEA Console, select Help > 
Contents. In the help viewer’s table of contents, expand the SANPoint Control QuickStart 
help set.

Manual pages for SANPoint Control QuickStart are installed by default in 
/opt/VRTSspqmn.
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Understanding How to Troubleshoot SANPoint Control QuickStart
Understanding How to Troubleshoot SANPoint Control 
QuickStart

If an issue arises while you are using SANPoint Control QuickStart, we recommend that 
you follow these steps:

1. Use the manuals’ troubleshooting appendixes to see if you can find the solution to 
your problem.

2. If your problem is not listed in the troubleshooting appendixes, check the TechNotes 
on the VERITAS Support Web site at http://support.veritas.com.

3. If you still can’t solve your problem, you can use the VRTSexplorer Diagnostic 
Program. Do the following:

a. Run VRTSexplorer as root. VRTSexplorer, also known as vxexplorer and 
vxexplore, is a tool provided by VERITAS Software Corporation that, when 
executed on a UNIX system, gathers some of the information that may be needed 
by VERITAS Technical Support to troubleshoot a problem.

Note If VRTSexplorer is not already installed, install it from the CD-ROM. Under 
the support directory are directories for each supported platform. In each 
directory is a README.VRTSspt file with installation instructions.

b. Transfer the resulting file to the VERITAS Support FTP server when asked.

c. Call VERITAS Technical Support (see “Contacting VERITAS” on page xxiv).
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Contacting VERITAS
Contacting VERITAS
For assistance with any of the VERITAS products, contact VERITAS Technical Support:

◆ U.S. and Canadian Customers: 1-800-342-0652

◆ International: +1-650-527-8555

◆ Email: support@veritas.com

For license information:

◆ Phone: 1-650-527-0300

◆ Email: license@veritas.com

◆ Fax: 1-650-527-0952

For software updates:

◆ Email: swupdate@veritas.com

For information on purchasing VERITAS products:

◆ Phone: 1-800-258-UNIX (1-800-258-8649) or 1-650-527-8000

◆ Email: vx-sales@veritas.com

For additional information about VERITAS and VERITAS products, visit the Web site at 
http://www.veritas.com.

For software updates and additional technical support information, such as TechNotes, 
product alerts, and hardware and software compatibility lists, visit the VERITAS Technical 
Support Web site at: http://support.veritas.com.
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Introducing SANPoint Control QuickStart
 1

VERITAS SANPoint Control QuickStart—part of the VERITAS Storage 
Foundation—provides automatic, accurate discovery and visualization of storage area 
network (SAN) devices and gives your SAN administrators a single, centralized, 
consistent interface for monitoring a multi-vendor storage network.

SANPoint Control QuickStart seamlessly integrates monitoring, storage allocation, and 
grouping capabilities with the VERITAS Enterprise Administrator (VEA) Console and 
also allows you to manage VERITAS Volume Manager disk volumes from within the 
same graphical user interface. 

This section contains the following topics:

“How a SAN Can Meet Your Storage Needs” on page 2

“The SANPoint Control QuickStart Solution” on page 5

“Licensing Levels” on page 9

“Operating System Platforms” on page 9
1



How a SAN Can Meet Your Storage Needs
How a SAN Can Meet Your Storage Needs
For most organizations, the volume of data is exploding—growing from 50 percent to 400 
percent every year as they adopt e-commerce, supply chain management, messaging, and 
other data-intensive applications. Even more storage is required to digitize manuals, 
corporate records, and other paper-based information, and to hold the files that include 
increasing amounts of multimedia content.

If all that volume and complexity weren’t enough of a management challenge, today’s 
business environments demand that all this data be available immediately, continuously, 
and from anywhere—to multiple applications and to hundreds, thousands, or even 
millions of users.

In the past, large organizations relied heavily on parallel SCSI technology to provide the 
performance required for their enterprise data storage needs. More recently, organizations 
are recognizing that the restrictions imposed by SCSI architecture are too costly for SCSI 
to continue as a viable solution. 

To overcome these restrictions, some organizations have turned to a network-attached 
storage (NAS) model that enables storage arrays to reside directly on the network, where 
disk accesses may be made directly rather than through the server’s SCSI connection. 
However, this model adds a significant load to the network, which frequently is already 
starved for bandwidth. A more elegant solution is needed.

The SAN Model
The storage area network (SAN) model places storage on its own dedicated network, 
removing data storage from both the server-to-disk SCSI bus and the main user network. 
This dedicated network most commonly uses Fibre Channel technology, a versatile, 
high-speed transport. The SAN includes one or more hosts that provide a point of 
interface with LAN users, as well as (in the case of large SANs) one or more fabric 
switches and SAN hubs to accommodate a large number of storage devices.

There are several advantages to the implementation of a high-performance network 
exclusively for storage devices:

◆ The LAN is relieved of the overhead of disk access and tape backup

◆ Data availability becomes less server-dependent

◆ Downtime incurred by service and maintenance tasks affects more granular portions 
of the available storage system

The versatility of the SAN model enables organizations to perform tasks that were 
previously difficult to implement, such as LAN-free and server-free tape backup, storage 
leasing, and full-motion video services. 
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How a SAN Can Meet Your Storage Needs
Storage Virtualization
SANPoint Control QuickStart is an integral part of a storage virtualization solution. Storage 
virtualization is the process of taking multiple physical storage devices and combining 
them into logical (virtual) storage devices that are allocated to applications and users at 
will. Storage virtualization builds a layer of abstraction above the physical storage to ease 
management of complex storage environments.

Virtualization is not a new concept. In fact, for more than a decade products such as 
VERITAS Volume Manager have provided virtualization in open systems from the 
standpoint of a single host or a single array. 

Today, SANPoint Control QuickStart enables you to take advantage of storage 
virtualization services over the entire storage network, across all SAN storage and server 
platforms. You also get centralized storage resource management capabilities such as 
hardware discovery, visualization, and reporting.

Fabrics and Virtual Fabrics
One of the most common ways of grouping and managing SAN objects is by fabrics. A 
fabric is a group of SAN objects connected by a single switch. Organizing objects in this 
way makes it easy for a SAN administrator to see the interconnections between objects 
and perform operations on all of the objects in a fabric.

For some switches that have Fibre Channel (FC) capability, you can create virtual fabrics 
(also known as virtual SANs or VSANs) to achieve even greater security and scalability.  
When you create virtual fabrics, you are in effect creating multiple logical fabrics, each of 
which can be managed as a single logical entity.

Virtual Fabrics can save you money by consolidating physically separate switch 
topologies into one physical topology that can be managed as a single logical entity. Each 
logical topology is easier to manage and keep secure. 

Tasks Performed by the SAN Administrator
Because SANs are a relatively new technology, the job of SAN administrator is often filled 
by people with various skill sets and work backgrounds: mainframe operators, traditional 
network administrators, system administrators, and others in the IT industry.

Keeping the SAN secure is vital. To protect against security breaches from outside the 
SAN, the SAN administrator usually works in conjunction with network administrators 
and others in the IT department. Security within the SAN, however, is often solely the 
SAN administrator’s responsibility. The SAN administrator, therefore, is typically 
expected to secure the SAN and develop a data protection strategy.

Here are some of the other tasks a SAN administrator typically performs:
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How a SAN Can Meet Your Storage Needs
◆ Administering SAN resources—for example allocating storage to hosts and the 
applications that run on them, and defining logical groups for easier management

◆ Testing new vendors’ hardware and integrating it into the SAN

◆ Troubleshooting SAN elements

◆ Managing day-to-day performance and SAN resource availability

The next section describes how SANPoint Control QuickStart helps the SAN 
administrator perform these tasks.
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The SANPoint Control QuickStart Solution
SANPoint Control QuickStart maximizes the return on your SAN technology investment 
by helping the SAN administrator make your SAN operate as effectively as possible.

SANPoint Control QuickStart provides the following tools:

◆ In-band and out-of-band discovery methods for discovering a wide range of SAN 
objects including fabrics, hosts, groups, and applications.

◆ A rich set of graphical and textual displays for visualizing SAN resources—such as 
fabrics, storage devices, and groups—as well as inventory reports about objects on the 
SAN.

◆ Integration with other VERITAS products, including the ability to manage VERITAS 
Volume Manager volumes from within the VERITAS Enterprise Administrator (VEA) 
Console.

◆ Support for features of Cisco MDS 9000 series switches, such as virtual fabrics and 
port bundles, that are designed to increase the efficiency and flexibility of your SAN.

(For a complete listing of the storage devices supported by SANPoint Control QuickStart, 
see the VERITAS SANPoint Control QuickStart 4.0 Hardware and Software Compatibility List.)

Based on a distributed client-server architecture, SANPoint Control QuickStart is divided 
into three separate components:

◆ A VEA Console extension displays information compiled from the SAN Access Layer 
(SAL) and other sources within the SANPoint Control QuickStart Server. The VEA 
Console provides a central point to display the SAN topology and visualize fabrics 
(including virtual fabrics), access detailed information about components, and view 
inventory reports.

◆ The SANPoint Control QuickStart Server provides discovery of SAN objects and their 
attributes. 

◆ The SANPoint Control QuickStart Agent discovers additional information about 
objects on the SAN that may be configured out of view of the Server (such as those 
devices on a separate zone or fabric). The Agent performs discovery in-band as well as 
through common HBA API and IOCTLs.

The following sections describe each of these components and their roles in discovering 
and managing objects on the SAN.
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The SANPoint Control QuickStart Solution
The VEA Console
The VERITAS Enterprise Administrator (VEA) Console displays data about SAN objects 
in graphical form and provides a user interface for the many tools and functions in 
SANPoint Control QuickStart.

The VEA Console includes the following features for all users:

◆ A user-customizable topographical display of every discovered object on the SAN

◆ Detailed information on object attributes and connectivity

◆ Filter views that draw a subset of the SAN topology based on the object currently 
selected

◆ Visualization of fabrics and virtual fabrics

◆ The ability to manage VERITAS Volume Manager disk volumes from within the 
SANPoint Control QuickStart portion of the VEA Console

◆ Pre-defined inventory reports about objects on the SAN

◆ An Enclosure Wizard for creating and managing SAN object enclosures

◆ A Host Wizard for creating and managing hosts on the SAN

◆ A Group Wizard for creating and managing groups of SAN objects

◆ A Device Wizard for creating and managing other devices on the SAN

The SANPoint Control QuickStart client application is automatically downloaded to your 
Solaris or Windows client when you install the VEA Console and then connect to a server 
on which SANPoint Control QuickStart is installed.

For more information about using SANPoint Control QuickStart functions in the VEA 
Console, see “Visualizing Objects on the SAN” on page 11.
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The SANPoint Control QuickStart Server 

The SANPoint Control QuickStart Server constantly explores your SAN to make data 
available to client applications. The functions of the QuickStart Server are to:

◆ Automatically discover SAN-attached objects including hosts, HBAs, switches, 
bridges, and storage devices such as JBODs and tape drives. (Configuration is 
required for discovery of some devices.)

◆ Monitor the SAN topology

◆ Provide data for inventory reports that are generated within the VEA Console.

◆ Support user-defined grouping of objects based on quality of service (QoS) criteria

SANPoint Control QuickStart ships with several explorers. Each explorer is a software tool 
that uses a unique methodology to discover information about a particular kind of object 
on the SAN.

The explorers provided in SANPoint Control QuickStart can discover the following SAN 
elements:

◆ Physical entities such as switches, host bus adapters (HBAs), bridges, routers, and 
other devices.

◆ Logical groupings of entities such as enclosures, zones, and virtual hubs.

◆ Information about VERITAS Volume Manager hosts, NetBackup applications, and 
Cluster Server clusters, along with application-specific objects such as Oracle and DB2 
database instances.

◆ Attributes—such as name, host, and capacity—for address units (LUNs) that are 
controlled by VERITAS Volume Manager.

The SAN Access Layer (SAL), running on the SANPoint Control QuickStart Server, 
coordinates the activity of the explorers and collects the data they gather into a SAN 
discovery data store. The data store is constantly updated with real-time information 
about objects on the SAN.

SAL also performs the following functions:

◆ Interprets information in the SAN discovery data store, which it provides to the VEA 
Console as well as to other client applications such as the full SANPoint Control 
product.

◆ Enforces user authentication for commands sent to the Server.

◆ Handles communication between the Server and Agent hosts.

For more information about setting up and using the QuickStart Server for discovery, and 
for information about using the data in the SAN discovery data store, see SANPoint 
Control QuickStart Installation and Configuration Guide.
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The SANPoint Control QuickStart Agent 
Because not all objects on the SAN may be visible to the machine on which the SANPoint 
Control QuickStart Server is installed, the SANPoint Control QuickStart Agent assists the 
QuickStart Server in discovering the entire SAN. For example, the QuickStart Agent can 
discover objects like HBAs, clusters, OS handles, and applications on the host where it is 
installed.

The QuickStart Agent consists of several SAN explorers that are also used by the 
QuickStart Server, including explorers that discover Fibre Channel-capable switches and 
devices managed over IP networks. 

For the most complete and accurate discovery, it is best to install the QuickStart Agent on 
every host in your SAN. However, if an QuickStart Agent is not installed (either by choice 
or because the host is running a non-supported operating system), the QuickStart Server 
can still discover HBAs on the host and display them as unidentified adapters.  You can 
then use the Host Wizard to enclose the HBAs into host enclosures.
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Licensing Levels
Licensing Levels
SANPoint Control QuickStart enables you to perform tasks such as basic discovery and 
visualization of SAN objects, manually creating enclosures for grouping storage devices, 
and configuring the SAN.

With the full SANPoint Control product, you can perform all tasks associated with 
managing and administering your SAN, including policy-based monitoring of SAN 
activity. For details about the functions available with the full product, see “Features in the 
SANPoint Control Product Family” on page xv. 

If you would like to upgrade from SANPoint Control QuickStart to its parent product, 
which contains additional features for managing your SAN, contact your VERITAS sales 
representative.

Operating System Platforms
The SANPoint Control QuickStart Server and the SANPoint Control QuickStart Agent are 
supported on the Solaris operating system platform.

The VEA Console can be installed on Solaris, Windows 2000, or Windows XP 
Professional.
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Visualizing Objects on the SAN
 2

The VERITAS Enterprise Administrator (VEA) Console is a graphical user interface that 
displays information about SAN objects in an intuitive, easily navigable form. The VEA 
Console provides a central point with which to monitor the SAN and display information 
about SAN objects.

This section contains the following topics:

“The VERITAS Enterprise Administrator (VEA) Console Window” on page 12

“Viewing SAN Objects in the Tree View” on page 14

“Viewing SAN Objects in the Topology Map” on page 15

“Displaying Details about SAN Objects” on page 25

“Enabling the Display of Additional SAN Information” on page 27
11



The VERITAS Enterprise Administrator (VEA) Console Window
The VERITAS Enterprise Administrator (VEA) Console 
Window 

In the VERITAS Enterprise Administrator (VEA) Console window, there are two areas 
where SANPoint Control QuickStart displays SAN information in complementary 
formats:

◆ Tree View or Navigational View—contains a directory tree of all the objects on the 
SAN. The Tree View displays SAN objects in a number of different ways. See 
“Viewing SAN Objects in the Tree View” on page 14 for details about the Tree View.

◆ Details View—includes several panes (tabs), each of which provides a different form 
of information about your SAN. Depending on the type of object or group you select 
in the Tree View, a different set of panes is available to select. See “Displaying Details 
about SAN Objects” on page 25 for more information about the Details View.

One of the Details View panes contains the Topology Map, a graphical representation 
of the objects on your SAN. Other panes display the object’s attributes and other 
information about the object. 
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The VERITAS Enterprise Administrator (VEA) Console Window
Main Elements of the VERITAS Enterprise Administrator (VEA) Console

Tree View
Topology Map

Menu Bar

Title Bar

Toolbar

Details View Tabs

Storage Networks tab
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Viewing SAN Objects in the Tree View
The Tree View, on the left side of the VERITAS Enterprise Administrator (VEA) Console, 
contains a directory tree of SAN objects. Using the Tree View, you can view SAN objects 
organized according to any of the following object types:

◆ Applications, such as VERITAS Cluster Server and Volume Manager

◆ Bridges and routers

◆ Clusters

◆ Fabrics

◆ Groups

◆ Hosts

◆ Hubs

◆ Storage, including enclosures and unenclosed storage

◆ Unidentified Adapters

For each object type, a separate branch corresponds to each object of that type. You can 
open a number of sub-branches to display details about the object you have selected. For 
example, when you select a fabric you can display sub-branches for the fabric’s switches, 
zones, and zone aliases.

▼ To display a SAN object in the Tree View

1. Select the Storage Networks tab at the top of the Tree View.

2. In the Tree View, select the expand icon (plus sign) to expand the branch that 
corresponds to the object type you want to display.

3. Select the object.
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Viewing SAN Objects in the Topology Map
Viewing SAN Objects in the Topology Map
The Topology Map, displayed in the Details View when the Topology tab is selected, 
provides a visual representation of your SAN. The Topology Map displays not only the 
objects on the SAN, but the connections between objects as well.

▼ To display SAN objects in the Topology Map

1. Select the Storage Networks tab at the top of the Tree View.

2. Select the Topology tab at the top of the Details View. 

A graphical representation of all the objects on your SAN, including connections 
between objects, is displayed.
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Viewing SAN Objects in the Topology Map
Moving Objects in the Topology Map
You can move objects in the Topology Map to help you focus on the ones you are most 
interested in, or to group objects together.

▼ To move an object in the Topology Map

1. Select (single-click) the object. 

A dotted rectangle around the object indicates that the object is ready to be moved.

2. Drag the object to its new location.

Note that when you drag an object and move it to a new location, the lines that represent 
its connections with other objects are repositioned as well.

▼ To restore all objects in the Topology Map to their original positions

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Reset Node Positions.
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Expanding an Object to Display Subordinate Objects
Some object types—enclosures, fabrics, and bridges—are displayed in the Topology Map 
as a single icon even though they have subordinate objects such as storage devices or 
switches. You can expand the icon to show all of the subordinate objects. An expandable 
object is identified by a plus sign next to its icon.

An Expanded Object Displayed in the Topology Map

▼ To expand a fabric or enclosure in the Topology Map

1. Display a context menu by right-clicking the object’s icon.

2. Select Expand.

The object and its subordinate objects are displayed inside a blue rectangle.

▼ To hide the children of an object

1. Display a context menu by right-clicking an object within an expanded fabric or 
enclosure.

2. Select Hide Children.

To undo this operation, right-click the object and select Show Children.
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Viewing SAN Objects in the Topology Map
▼ To restore an object to its original appearance

1. Display a context menu by right-clicking the frame that surrounds the object and its 
subordinate objects.

2. Select Collapse.
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Viewing SAN Objects in the Topology Map
Selecting the Topology Map Layout
You can choose from four different Topology Map layouts. The layout you use is usually a 
matter of visual preference, however there are some underlying design assumptions in 
each layout which may influence when and why you use one layout instead of another. 
The four layout options are:

The circular layout—the default layout—arranges the SAN objects in circular patterns 
that represent groups of objects connected to various ports on the switch.

The fan layout positions the switches at the top of the Topology Map and fans all devices 
and hosts out at a level below the switches in a symmetrical fashion.

The hierarchical layout positions the switches at the top of the Topology Map and shows 
other SAN objects arranged in hierarchical fashion below them.

The network layout emphasizes the switches on your SAN by displaying them centrally 
among the various other objects to which they connect.

▼ To select the Topology Map layout

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Change Layout.

3. In the Change Layout dialog box, do the following:

a. Select the layout you want.

b. Select Set as default layout if you want to have this layout display every time you 
invoke the Topology Map.

c. Select OK.

The layout in the Topology Map changes to the layout you selected.
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Viewing SAN Objects in the Topology Map
Zooming on the Topology Map
You can zoom in or out on the Topology Map, controlling what objects display in the 
Topology Map and their magnification level.

▼ To zoom in on the Topology Map

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Zoom > Zoom In.

The view in the Topology Map is refreshed. A smaller portion of the map is visible, 
and objects appear larger.

▼ To zoom in on the Topology Map using the keyboard

❖ Hold down the Alt and Shift keys while you press + (the plus sign).

The view in the Topology Map is refreshed. A smaller portion of the map is visible, 
and objects appear larger.

▼ To zoom out on the Topology Map

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Zoom > Zoom Out.

The view in the Topology Map is refreshed. A larger portion of the map is visible, and 
objects appear smaller.

▼ To zoom out on the Topology Map using the keyboard

❖ Hold down the Alt key while you press - (the minus sign).

The view in the Topology Map is refreshed. A larger portion of the map is visible, and 
objects appear smaller.

▼ To customize the Topology Map’s zoom level 

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Zoom > Custom Zoom.

3. In the Custom Zoom dialog box, type a zoom level in the text box. The zoom level 
should be a whole number between 1 and 200. 
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The larger the number, the more the display will be zoomed in—a smaller portion of 
the map is visible, and objects appear larger.

4. Select OK to set the Topology Map zoom level.

The view in the Topology Map is refreshed with the specified zoom level.

▼ To return to the default Topology Map zoom setting

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Zoom > Fit in Window.

The view in the Topology Map is refreshed so that all of the SAN objects fit in the 
window.
Chapter 2, Visualizing Objects on the SAN 21



Viewing SAN Objects in the Topology Map
Filtering in the Topology Map
Because it might be difficult to navigate the Topology Map for a large, complex SAN, you 
can use the Filter View to focus on particular objects of interest and view only those 
objects in the Topology Map.

▼ To filter the view in the Topology Map

1. Select an object in the Tree View.

2. Display the Topology Map by selecting the Topology tab in the Details View.

3. Select the Filter View button at the bottom of the Topology Map.

The Topology Map shows only the object that is selected in the Tree View. If the object 
is expandable—a fabric, for example—then an expanded view of the object is shown.

▼ To restore the unfiltered display in the Topology Map

❖ Select the Filter View button again.
22 SANPoint Control QuickStart Overview Guide



Viewing SAN Objects in the Topology Map
Using the Overview Window to Display a Part of the SAN
At times, a large SAN with many devices may be difficult to represent legibly within the 
space allotted to the Topology Map. You can use the Overview Window to pan across the 
Topology Map and zoom in on a particular part of the SAN.

▼ To launch and use the Overview Window

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Overview.

3. In the Overview Window, resize the frame by dragging its corners. 

4. Click and drag the frame to the area you want to display.

As you drag the frame, objects inside the frame are magnified within the Topology 
Map itself.

▼ To undo the Overview Window magnification

1. Display a context menu by right-clicking anywhere in the Topology Map.

2. Select Zoom > Fit in Window.
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Refreshing the View in the Topology Map
Select the Refresh button at the bottom of the Topology Map to update the display of SAN 
objects and restore the default settings for viewing the map.

When you select Refresh, the following things take place:

◆ The display of SAN objects updates to reflect the current condition of your SAN.

◆ Expanded objects return to their collapsed state.

◆ Objects display using the default circular layout.

◆ Objects display using the default zoom setting.

◆ Filtering turns OFF.

◆ The Overview Window closes.

If you have moved objects in the Topology Map, they remain in their new positions. (To 
return the objects to their original positions, right-click in the Topology Map and select 
Reset Node Positions.)
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Displaying Details about SAN Objects
The Details View displays by default in the right side of the VERITAS Enterprise 
Administrator (VEA) Console. It includes several panes (tabs), each of which provides a 
different form of information about the objects on your SAN. 

▼ To display details about a SAN object

1. Select an object in the Tree View.

2. At the top of the Details View, select the tab corresponding to the kind of information 
you want to display.

Information about the object is displayed in the Details View.

The Details View (Showing the Connectivity Pane)

Depending on the type of object or group you select in the Tree View, a different set of 
panes is available in the Details View. The following panes are always available:

◆ The Attributes pane displays detailed information about the object or directory you 
select in the Tree View. 

◆ The Topology Map provides a visual representation of your SAN. See “Viewing SAN 
Objects in the Topology Map” on page 15 for details.
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Other panes are available in the Details View depending on the type of object you select in 
the Tree View:

◆ The Connectivity pane displays, for the selected object, information about the switch 
ports to which it is connected.

◆ The OS Handles pane displays—for hosts, HBAs, storage devices containing at least 
one LUN, and individual LUNs—the relationships between HBA ports and the LUNs 
that are accessible to them (the LUNs that are masked to those HBA ports).

◆ The Zone Members pane displays, for a zone that is selected in the Tree View, the zone 
definition and the objects in the zone, including parent objects that are members of the 
zone by virtue of the zone definition.

◆ The Group Members pane displays, for a group that is selected in the Tree View, the 
group definition and the objects in the group, including parent objects that are 
members of the group by virtue of the group definition.
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Enabling the Display of Additional SAN Information
The SANPoint Control QuickStart Server can discover information about HBAs on hosts 
that are attached to fabrics discovered by the QuickStart Server host. If you want QS to 
perform additional discovery, so that information about more SAN objects is displayed in 
the VERITAS Enterprise Administrator (VEA) Console, you must install the SANPoint 
Control QuickStart Agent software on each host and register each Agent with the 
QuickStart Server.

Additionally, if you want to be able to display information from fabrics that are not 
attached to the QuickStart Server, you must install the QuickStart Agent software on at 
least one host in the remote fabric and specify it on the QuickStart Server to discover the 
fabric.

To configure QuickStart Agent hosts for discovery, so that information about more SAN 
objects is displayed in the VEA Console, select Tools > SANPoint Control QuickStart > 
Configure Agent Hosts in the menu bar. See “Configuring the Server for Agent 
Discovery” in SANPoint Control QuickStart Installation and Configuration Guide for details.
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Creating and Modifying SAN Objects
 3

This section introduces SAN objects and attributes that you can define. It explains how to 
create objects and manage them.

This section contains the following topics:

“SAN Objects You Can Create” on page 30

“Creating, Modifying, and Deleting Device Objects” on page 31

“Creating, Modifying, and Deleting Enclosure Objects” on page 34

“Creating, Modifying, and Deleting Host Objects” on page 37

“Managing Volume Manager Disk Volumes” on page 40
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SAN Objects You Can Create 
In some cases, SANPoint Control QuickStart neither discovers nor displays certain SAN 
elements. In other cases, although a SAN element is not discoverable, SANPoint Control 
QuickStart permits you to manually create an object in the SAN discovery data store to 
represent that element.

Generic Devices

Occasionally, an unidentified node may belong to a SAN-attached device that is 
undiscoverable by SANPoint Control QuickStart. You can create a device object to 
represent the physical device that contains the node.

For more information, see “Creating, Modifying, and Deleting Device Objects” on 
page 31.

Storage Enclosures

A storage enclosure is a method of grouping SAN objects together so that you can 
visualize them, and perform operations on them, as if they were a single object—for 
example a JBOD. SANPoint Control QuickStart discovers some enclosures automatically, 
but in many cases it discovers only the individual storage devices inside the enclosure. 
Using the Enclosure Wizard, you can create an enclosure object and specify which devices 
it contains.

For more information, see “Creating, Modifying, and Deleting Enclosure Objects” on 
page 34.

Hosts

If a host on the SAN is not running either the SANPoint Control QuickStart Server or the 
Agent, SANPoint Control QuickStart discovers only its HBA nodes, which appear as 
unidentified adapters in the VERITAS Enterprise Administrator (VEA) Console. Using the 
Host Wizard, you can create a host object to represent the physical host that contains that 
HBA node. You can also specify certain attributes of the host, which SANPoint Control 
QuickStart adds to the data store.

For more information, see “Creating, Modifying, and Deleting Host Objects” on page 37.
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Creating, Modifying, and Deleting Device Objects
In some circumstances, SANPoint Control QuickStart may not be able to completely 
discover a storage device on the SAN. This occurs when three conditions are met:

◆ The switch name server does not provide enough information (a SCSI INQUIRY 
string) to determine whether a discovered adapter belongs to an HBA or a device. In 
some cases this is because of a limitation in the switch. In other cases the device 
simply does not register a SCSI INQUIRY string when logging onto the fabric.

◆ No SANPoint Control QuickStart Server or QuickStart Agent can see the object—for 
example, when it is zoned out of view of the host.

◆ The object’s vendor (a discoverable attribute) is not known to be a storage vendor.

In such a case, the device appears in the VERITAS Enterprise Administrator (VEA) 
Console as an unidentified adapter.

The Device Wizard allows you to identify an unidentified adapter node as a storage 
device so that it appears correctly in the VEA Console.

▼ To create a generic storage device object from an unidentified node

1. In the VEA Console menu bar, select Wizards > Device.

2. In the Welcome panel of the Device Wizard, select Next.

3. In the Specify Device Details panel, do the following:

a. Select Create.

b. Type a name for the new device.

The device name may consist of alphanumeric characters and underscores.

c. Type the appropriate information—such as its type, its vendor name, or its 
physical location—in the Device Information field. (This field is optional.)

d. Select Next.

4. In the Specify Device Nodes panel, do the following:

a. Select the checkbox next to each node that represents a node within the device.

b. Select Next.

5. In the Confirm Device Selections panel, do the following:
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a. Examine the attributes shown in the Device Attributes fields for accuracy.

b. Examine the nodes shown in the Nodes list for accuracy.

c. Select Finish to confirm your selections and create the device object, or select 
Back to go back and make changes.

A progress window opens to track the execution of the command by the SANPoint 
Control QuickStart Server. You can close the window at any time.

▼ To modify a storage device object

1. In the VEA Console menu bar, select Wizards > Device.

2. In the Welcome panel of the Device Wizard, select Next.

3. In the Specify Device Details panel, do the following:

a. Select Modify.

b. Select the device from the drop-down list.

c. Update the information in the Device Information field. (This field is optional.)

d. Select Next.

4. In the Specify Device Nodes panel, do the following:

a. Select the checkbox next to each node you want to add to the device object.

b. Deselect the checkbox next to each node you want to remove from the device 
object.

c. Select Next.

5. In the Confirm Device Selections panel, do the following:

a. Examine the attributes shown in the Device Attributes fields for accuracy.

b. Examine the nodes shown in the Nodes list for accuracy.

c. Select Finish to confirm your selections and create the device object, or select 
Back to go back and make changes.

The definition for the device object has been updated.
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▼ To delete a storage device object

1. Display a context menu by right-clicking a storage device object in the Tree View.

2. Select Delete.

The object is deleted. Because user-defined storage device objects serve as symbolic 
rather than functional groupings of nodes, the nodes themselves are not affected 
when you delete a storage device object.
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Creating, Modifying, and Deleting Enclosure Objects
Some storage enclosures (groups of storage devices) are discovered automatically by 
SANPoint Control QuickStart. For enclosures that are not discoverable, you can manually 
create a representation of the enclosure object in the SAN discovery data store. Use the 
Enclosure Wizard to specify the type of enclosure and which devices are contained within 
it.

▼ To create a new enclosure

1. In the VEA Console menu bar, select Wizards > Enclosure.

2. In the Welcome panel of the Enclosure Wizard, select Next.

3. In the Create or Modify an Enclosure panel, do the following:

a. Select Create.

b. Type a name for the new enclosure.

The enclosure name may consist of alphanumeric characters and underscores.

c. Type the appropriate information in the Vendor Name and Model Number 
fields. (These fields are optional.)

d. In the Type drop-down list, select the enclosure type—disk array, robotic array, or 
JBOD.

e. Select Next.

4. In the Add or Remove Enclosure Members panel, do the following:

a. Highlight an object in the Available Objects list. To display lower-level objects, 
use the expand icons (plus signs).

b. Select Add to add the selected object to the enclosure.

c. Repeat steps a and b to add more objects.

d. When you have placed all the objects you want into the Enclosure Objects list, 
select Next.

5. In the Confirm Selections panel, do the following:
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a. Check your selections for accuracy.

b. Select Finish to confirm your selections and create the new enclosure, or select 
Back to go back and make changes.

▼ To add objects to, or remove objects from, an existing enclosure

1. In the VEA Console menu bar, select Wizards > Enclosure.

2. In the Welcome panel of the Enclosure Wizard, select Next.

3. In the Create or Modify an Enclosure panel, do the following:

a. Select Modify.

b. Select the enclosure from the drop-down list.

c. Update the information in the Vendor Name and Model Number fields, if 
desired.

d. Select Next.

4. In the Add or Remove Enclosure Members panel, do the following:

a. To add an object to the enclosure, highlight the object in the Available Objects list 
and select Add.

b. To remove an object, highlight the object in the Enclosure Objects list and select 
Remove.

c. Repeat steps a and b until the Enclosure Objects list contains all the objects you 
want the enclosure to have.

d. Select Next.

5. In the Confirm Selections panel, do the following:

a. Check your selections for accuracy.

b. Select Finish to confirm your selections, or select Back to go back and make 
changes.

The definition for the enclosure has been updated.
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▼ To delete an enclosure

1. Display a context menu by right-clicking an enclosure in the Tree View.

2. Select Delete.

The enclosure is deleted. Because user-defined enclosures serve as symbolic rather 
than functional groupings of storage devices, the devices themselves are not affected 
when you delete an enclosure.
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Creating, Modifying, and Deleting Host Objects
If a host system on the SAN is not running either the SANPoint Control QuickStart Server 
or the Agent, then SANPoint Control QuickStart discovers only the adapter (HBA) that 
connects that host to the SAN.

You can manually create a host object to contain an unidentified adapter that was 
discovered on the SAN. Use the Host Wizard to specify the host name, IP address, and 
any discovered HBA nodes that represent HBAs in the host.

▼ To create a new host object

1. In the VEA Console menu bar, select Wizards > Host.

2. In the Welcome panel of the Host Wizard, select Next.

3. In the Specify Host Details panel, do the following:

a. Select Create.

b. Type a name for the new host.

The host name may consist of alphanumeric characters and underscores.

c. Type the host’s IP address in the IP address field. (This field is optional.)

d. Type notes or other information in the Host information field. (This field is 
optional.)

e. Select Next.

4. In the Specify Host Host Bus Adapters panel, do the following:

a. Select the checkbox next to each HBA node that represents an HBA within the 
host object.

b. Select Next.

5. In the Confirm Host Selections panel, do the following:

a. Examine the attributes shown in the Host Attributes fields for accuracy.

b. Examine the HBA nodes shown in the Host Bus Adapters list for accuracy.

c. Select Finish to confirm your selections and create the new host object, or select 
Back to go back and make changes.
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▼ To modify a host object

1. In the VEA Console menu bar, select Wizards > Host.

2. In the Welcome panel of the Host Wizard, select Next.

3. In the Specify Host Details panel, do the following:

a. Select Modify.

b. Select the host from the drop-down list.

c. Update the host’s IP address in the IP address field. (This field is optional.)

d. Update information in the Host information field. (This field is optional.)

e. Select Next.

4. In the Specify Host Host Bus Adapters panel, do the following:

a. Select the checkbox next to each HBA node you want to add to the host object.

b. Deselect the checkbox next to each HBA node you want to remove from the host 
object.

c. Select Next.

5. In the Confirm Host Selections panel, do the following:

a. Examine the attributes shown in the Host Attributes fields for accuracy.

b. Examine the HBA nodes shown in the Host Bus Adapters list for accuracy.

c. Select Finish to confirm your selections, or select Back to go back and make 
changes.

The definition for the host object has been updated.

▼ To delete a host object

1. Display a context menu by right-clicking a host in the Tree View.

2. Select Delete.
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The host is deleted. Because user-defined hosts serve as symbolic rather than 
functional groupings of HBAs, the HBAs themselves are not affected when you delete 
a host.
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Managing Volume Manager Disk Volumes
You can manage VERITAS Volume Manager disk volumes from within the VERITAS 
Enterprise Administrator (VEA) Console. By accessing Volume Manager functions 
directly from the VEA Console window, you can change a volume’s size or layout, create a 
mirror disk, and perform other management functions.

For details about the Volume Manager functions that are available from within the VEA 
Console, see the Volume Manager documentation.

▼ To perform management tasks on a volume controlled by Volume Manager

1. Display a Volume Manager disk group in the Tree View.

2. Display a context menu by right-clicking the disk group.

3. Select Manage.

VEA initiates a connection to the host on which the disk group resides.

4. Supply authorization credentials if you are prompted for them.

When you connect to the Volume Manager host, the controls in the VEA Console—such as 
the tabs in the Details View, the icons on the Toolbar, and the contents of the context 
(right-click) menu—change so that Volume Manager functions are displayed.

When you select other objects in the Tree View, such as fabrics and hosts, the controls in 
the VEA Console return to their SANPoint Control QuickStart settings. In this way you 
can easily move back and forth between the SANPoint Control QuickStart environment 
and the Volume Manager environment.

When you are done using the Volume Manager functions, you can disconnect from the 
Volume Manager host and continue working in the SANPoint Control QuickStart 
environment.

For more information about using Volume Manager, see the Volume Manager 
documentation.

▼ To exit the Volume Manager environment

1. Select the Disconnect icon on the VEA Console Toolbar.

2. In the Disconnect dialog box, select the name of the Volume Manager host.

3. Select OK.
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 4

The topics in this section describe two services that are designed to help administrators 
maintain a quality of storage service for SAN-attached servers.

This section contains the following topics:

“Using Groups to Simplify SAN Management” on page 42

“Viewing Members of Groups” on page 44

“Creating, Modifying, and Deleting Groups” on page 45

“Using Zones to Allocate Storage Resources” on page 48

“Viewing Members of Zones” on page 50

“Viewing the Zones to which an Object Belongs” on page 51

“Viewing Zone Aliases and their Members” on page 52

“Using Virtual Fabrics for Enhanced Security” on page 53
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Using Groups to Simplify SAN Management
A group is an arbitrary set of SAN elements defined by an administrator to help organize 
and provision resources. For example, you might define a group that contains all of the 
storage devices associated with a particular application.

To view your groups in the VERITAS Enterprise Administrator (VEA) Console, expand 
the Groups object in the Tree View. When you select a group in the Tree View, its member 
objects are listed in the Group Members tab in the Details View.

Types of Groups
SANPoint Control QuickStart supports three different types of groups, which are 
described in the table below:

Types of Groups Supported by SANPoint Control QuickStart

Group Type Object Members Description

Generic group ◆ Switches

◆ Unidentified adapters

◆ Hosts

◆ Storage devices (storage 
appliances, enclosures, or 
unenclosed storage)

◆ Routers and bridges

◆ Nested groups (any type)

A generic group contains any type of object 
that can be grouped within SANPoint 
Control QuickStart.

Storage account ◆ Hosts

◆ Storage devices (storage 
appliances, enclosures or 
unenclosed storage)

◆ Routers and bridges

◆ Nested groups (storage 
accounts or storage groups 
only)

A storage account contains one or more 
SANPoint Control QuickStart Server hosts 
and all the storage that the administrator 
assigns to the host(s). You can use storage 
accounts to keep track of the storage 
resources provisioned for hosts on the 
SAN.

Storage group ◆ Storage devices (storage 
appliances, enclosures, or 
unenclosed storage)

◆ Routers and bridges

◆ Nested groups (storage 
groups only)

A storage group contains only storage 
devices. You can use storage groups to 
categorize storage resources by quality of 
service criteria including cost, 
performance, capacity, and location.
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Nested Groups 
You can nest groups within other groups, but only under the following conditions:

◆ Nested groups cannot introduce cyclic dependency. That is, if Group B is nested 
within Group A, Group A cannot then be nested within Group B, creating a loop. 
SANPoint Control QuickStart checks for cyclic dependency and prevents users from 
creating such a configuration.

◆ A generic group may contain any other type of group.

◆ A storage account may contain other storage accounts or storage groups, but it cannot 
contain generic groups.

◆ A storage group may contain other storage groups, but it cannot contain storage 
accounts or generic groups.

Group Member Exclusivity 
In certain cases, a member of a group may not become a member of another group. The 
rules governing group member exclusivity are as follows:

◆ An object may have membership in multiple generic groups. There is no member 
exclusivity applied to generic groups.

◆ If an object is already a member of a storage account, it cannot be added to another 
storage account.

◆ If an object is already a member of a storage group, it cannot be added to another 
storage group.

◆ Member exclusivity does not apply when nesting groups. By nesting one group 
within another, objects within the nested group become members of both groups.
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Viewing Members of Groups 
Use the VERITAS Enterprise Administrator (VEA) Console to view group members.

▼ To view group members in the Attributes pane

1. In the Tree View, select a group whose members you want to identify.

2. In the Details View, select the Group Members tab.

For each physical object with which a group member is associated, the Grouped 
Objects pane displays the object type and owning entity (such as a host or enclosure).

▼ To view group members in the Topology Map

1. In the Tree View, select a group whose members you want to identify.

2. In the Details View, select the Topology tab.

All members of the currently selected group are highlighted in the Topology Map.
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Creating, Modifying, and Deleting Groups
Use the Group Wizard to create groups on a SAN fabric, add or remove group members, 
and delete groups.

▼ To create a new group

1. In the VEA Console menu bar, select Wizards > Group.

2. In the Welcome panel of the Group Wizard, select Next.

3. In the Create or Modify a Group panel, do the following:

a. Select Create.

b. Type a name for the new group.

c. In the Description field, type a description for the group, describing its purpose, 
the type of objects in the group, or any other information. (This field is optional.)

d. In the Type drop-down list, select the type of group you want to create—generic 
group, storage account, or storage group.

e. Select Next.

4. In the Add or Remove Group Members panel, do the following:

a. Highlight an object or group in the Available Objects list. To display lower-level 
objects, use the expand icons (plus signs).

b. Select Add to add the selected item to the new group.

c. Repeat steps a and b to add more items to the group.

d. When you have placed all the items you want into the Group Objects list, select 
Next.

5. In the Confirm Selections panel, do the following:

a. Check your selections for accuracy.

b. Select Finish to confirm your selections and create the new group, or select Back 
to go back and make changes.
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▼ To add members to, or remove members from, an existing group

1. In the VEA Console menu bar, select Wizards > Group.

2. In the Welcome panel of the Group Wizard, select Next.

3. In the Create or Modify a Group panel, do the following:

a. Select Modify.

b. Select the group from the drop-down list.

c. Update the description in the Description field. (This is optional.)

d. Select Next.

4. In the Add or Remove Group Members panel, do the following:

a. To add a new group member, highlight an object or group in the Available 
Objects list and select Add, or select (check) the box next to the name of the object 
in the Group Objects list.

b. To remove a group member, highlight an object or group in the Group Objects list 
and select Remove, or deselect (uncheck) the box next to the name of the object in 
the Group Objects list.

c. Repeat steps a and b until the Group Objects list contains all the members you 
want the group to have.

d. Select Next.

5. In the Confirm Selections panel, do the following:

a. Check your selections for accuracy.

b. Select Finish to confirm your selections, or select Back to go back and make 
changes.

The group’s membership has been updated.

▼ To delete a group

1. Display a context menu by right-clicking a group object in the Tree View.

2. Select Delete.
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The group is deleted. Because user-defined groups serve as symbolic rather than 
functional groupings of SAN objects, the objects themselves are not affected when you 
delete a group.
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Using Zones to Allocate Storage Resources
The any-to-any connectivity of the SAN storage model offers great flexibility but at the 
same time poses security risks. Zoning helps alleviate that risk by providing a means of 
controlling access between objects on the SAN. By creating and managing zones, a SAN 
administrator can control host access to storage resources.

With SANPoint Control QuickStart you can view zones, zone aliases, and zone 
memberships that have been defined for your SAN.

Full zone management functionality—including the ability to create zones, delete zones, 
and change zone memberships—is available with the full SANPoint Control product. For 
information about ordering this product, contact your VERITAS sales representative.

Overview of Zoning
A zone is a set of objects within a SAN fabric that can access each other. Zones and their 
member objects are defined in zoning tables within the switches on the SAN fabric. When 
zoning is implemented on a SAN fabric, the switches consult the zoning table to 
determine whether one object is permitted to communicate with another object. Unless 
switches share a common zone membership in at least one zone, access between them is 
restricted.

Fabric zoning occurs at the level of individual nodes or ports attached to the SAN fabric. 
Zoning-enabled fabrics contain zoning tables that define each zone along with its member 
objects. These zones function in a way similar to virtual private networks (VPNs) on 
traditional networks.

There are two ways to enforce the access restrictions created by zones on the SAN:

Soft zoning, also called advisory zoning or WWN zoning, is enforced simply by filtering the 
visibility of objects on the SAN so that an object is aware of only the objects that share at 
least one zone membership with it. Soft zoning is flexible because, if an object’s physical 
connection to the SAN fabric changes, its zone memberships remain intact. However, soft 
zoning also has a security vulnerability: it does not actively prevent access between 
objects that belong to different zones. 

Hard zoning, or switch port zoning, occurs when the Fibre Channel switch actively blocks 
access to zone members from any objects outside the zone. Hard zoning offers strong 
security because it actively segregates zone members from the rest of the SAN fabric. 
However, it lacks the flexibility of soft zoning because objects lose their zone 
memberships whenever they are disconnected from a switch port and moved elsewhere 
on the SAN.
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Zone Aliases
A zone alias is a name given to an object or set of objects for zoning purposes. Zone aliases 
simplify zone administration by eliminating the repetitive entry of World Wide Names 
(WWNs) or port numbers. After assigning a zone alias to one or more objects, you can 
perform zoning operations on the alias instead of having to specify the individual ports 
and WWNs of the object(s).

Although zone aliases bear some similarities to user-defined groups, a zone alias differs 
from a group in three primary ways:

◆ A group may contain objects from multiple fabrics, but objects in a zone alias must be 
from one fabric.

◆ A group cannot be added to a zone, because the objects it contains may not be 
zone-capable or may reside on different fabrics.

◆ A group definition is specific to SANPoint Control QuickStart and is stored in the 
SAN discovery data store. By contrast, a zone alias exists independently of SANPoint 
Control QuickStart and is stored on the principal switch of the fabric.

You can use the VERITAS Enterprise Administrator (VEA) Console to view zone aliases 
and their members.
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Viewing Members of Zones 
Use the VERITAS Enterprise Administrator (VEA) Console to view members of zones.

▼ To view zone members in the Details View

1. In the Tree View, select a zone whose members you want to identify.

2. In the Details View, select the Zone Members tab.

The Zone Members pane displays two lists:

◆ Zone Definition—a list of the port objects that are actually defined as members of 
the zone

◆ Zoned Objects—objects that are zoned by virtue of a port object being included in 
the zone definition

▼ To view zone members in the Topology Map

1. In the Tree View, select a zone whose members you want to identify.

2. In the Details View, select the Topology tab.

All members of the currently selected zone are highlighted in the Topology Map.
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Viewing the Zones to which an Object Belongs 
Use the VERITAS Enterprise Administrator (VEA) Console to view the zone memberships 
for an object on the SAN.

▼ To view an object’s zone memberships in the Connectivity pane

1. In the Tree View, select an object whose zone memberships you want to view.

2. In the Details View, select the Connectivity tab.

The Zones table, in the lower part of the Connectivity pane, displays a list of the zones 
to which the object belongs.
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Viewing Zone Aliases and their Members
Use the VEA Console to view members of zone aliases.

▼ To view members of zone aliases in the Details View

1. In the Tree View, select a zone alias whose members you want to identify.

2. In the Details View, select the Zone Members tab.

The Zone Members pane displays two lists:

◆ Zone Definition—a list of the port objects that are actually defined as members of 
the zone alias

◆ Zoned Objects—objects that are zoned by virtue of a port object being included in 
the zone alias definition

▼ To view zone aliases in the Topology Map

1. In the Tree View, select a zone alias whose members you want to identify.

2. In the Details View, select the Topology tab.

All members of the currently selected zone alias are highlighted in the Topology Map.
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Using Virtual Fabrics for Enhanced Security
For some switches that have Fibre Channel (FC) capability, you can create virtual fabrics 
(also known as virtual SANs or VSANs) to achieve even greater security and scalability. 
For a description of virtual fabrics and how they work, see “Fabrics and Virtual Fabrics” 
on page 3.

Use the VERITAS Enterprise Administrator (VEA) Console to view virtual fabrics and the 
objects they contain.

▼ To view virtual fabrics and the objects they contain

1. In the Tree View, select a physical fabric in which virtual fabrics have been defined.

2. Select the expand icon (plus sign) next to the name of the fabric.

3. In the expanded list for the fabric, select the expand icon next to Virtual Fabrics.

A list of virtual fabrics displays.

4. Use expand icons to view the switch ports, zones, and other objects contained in any 
virtual fabric.
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Displaying Reports about SAN Objects
 5

SANPoint Control QuickStart ships with several out-of-the-box reports with which you 
can inventory and analyze your SAN. The reports display up-to-date inventory data 
about objects on the SAN.

This section contains the following topics:

“Displaying Reports” on page 56

“Printing Reports” on page 57

“Saving Report Data in a File” on page 58

“Types of Reports” on page 59

“Finding the Report You Need” on page 60
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Displaying Reports
Displaying Reports 
Use the Toolbar or the Tools menu in the VERITAS Enterprise Administrator (VEA) 
Console to display inventory reports about the objects on your SAN.

The Reporter Window (Showing the Fabric Inventory Report)

▼ To display reports

1. Select the Reports icon on the VEA Console Toolbar, or select Tools > SANPoint 
Control QuickStart > Reports in the menu bar.

The Reporter window displays.

2. In the Reporter window, select the report you want to display.

3. To display another report, select it from the tree view on the left side of the Reporter 
window, or from the drop-down list at the top of the window.

▼ To redisplay a report

❖ In the Reporter window, use the Previous Report and Next Report buttons (located 
immediately to the left of the drop-down list) to scroll among the reports you have 
already viewed.
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Printing Reports
Printing Reports
You can print the report that is currently displayed in the Reporter window.

▼ To print the currently displayed report

1. In the VEA Console menu bar, select File > Print or select the printer icon on the 
Toolbar.

2. Specify page setup options as desired.

3. Select OK.

4. Specify printer options as desired.

5. Select OK.
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Saving Report Data in a File
You can save data from the report that is currently displayed in the Reporter window. 
Data can be saved in any of three different formats:

◆ Comma-separated, for importing to a spreadsheet program

◆ HTML, for displaying in a Web browser

◆ Plain text

▼ To save report data to a comma-separated file

1. Display the report in the Reporter window.

2. In the VEA Console menu bar, select File > Export.

3. Specify a path and name for the file and select Save.

The report data is saved in comma-separated format in the location you specify. 

▼ To save report data to an HTML file

1. Display the report in the Reporter window.

2. In the Reporter window menu bar, select File > Save as HTML.

3. Specify a path and name for the file and select Save.

The report data is saved in an HTML file in the location you specify. 

▼ To save report data as plain text

1. Display the report in the Reporter window.

2. Do one of the following:

◆ Right-click within the report and select Edit > Copy.

◆ In the Reporter window menu bar, select Edit > Copy.

The report’s data is copied to your system’s buffer (clipboard). You can open a text 
editor or similar application to paste and view the report’s content.
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Types of Reports
The reports displayed by SANPoint Control QuickStart contain summary information in 
tabular form about different categories of SAN objects. The reports are based on 
information from the SAN discovery data store, which resides on the SANPoint Control 
QuickStart Server.

The reports are organized as follows:

◆ The Inventory Summary Report displays summary information about:

◆ Hosts and the applications running on them

◆ Fabrics and their associated switches

◆ Storage devices

◆ Groups

◆ The Inventory Detail Reports display detailed information about:

◆ Fabrics

◆ Switches

◆ Zones

◆ Hosts

◆ HBAs

◆ Enclosures

◆ LUNs

◆ Direct-attached storage (DAS) devices

◆ The Applications Detail Reports display detailed information about:

◆ Oracle servers, instances, tablespaces, and files

◆ DB2 instances, databases, and tablespaces

◆ Microsoft Exchange Server servers, files, and storage groups

◆ VERITAS Cluster Server clusters

Additional reporting functionality—including reports about SAN capacity, performance, 
errors, and alerts—is available with the full SANPoint Control product. For information 
about ordering this product, contact your VERITAS sales representative.
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Finding the Report You Need
Use the following list of questions to find the report you need.

How can I view a summary of the SAN’s physical makeup?

Inventory Summary Report

How can I view information about devices on the SAN, like switches and enclosures?

Switch Inventory Report

Host Inventory Report

Enclosure Inventory Report

Direct Attached Storage Inventory Report

How is storage partitioned within storage devices?

LUN Inventory Report

What storage is already masked to a particular host?

LUN Inventory Report

What storage is available for masking to a host?

Enclosure Inventory Report

Direct Attached Storage Inventory Report

What fabrics and virtual fabrics are defined on the SAN?

Fabric Inventory Report

What zones are defined on the SAN?

Zone Inventory Report

What groups are defined on the SAN?

Inventory Summary Report

Which LUNs are associated with specific hosts, and which are not?

LUN Inventory Report
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What storage is connected to hosts on the SAN, but not connected to the SAN itself?

Direct Attached Storage Inventory Report

How can I view information about hosts on the SAN?

Host Inventory Report

HBA Inventory Report

Where can I find more storage that’s available for a file system to use?

LUN Inventory Report

How can I view information about storage associated with specific applications?

VERITAS Cluster Server: Cluster Inventory Report

Oracle: Oracle Inventory Report

DB2: DB2 Inventory Report

Microsoft Exchange Server: Exchange Server Inventory Report
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Troubleshooting
 A

This section describes how to handle issues related to using SANPoint Control QuickStart 
functions in the VERITAS Enterprise Administrator (VEA) Console to view objects, arrays, 
HBAs and hosts, bridges, switches, and fabrics.

Many of the solutions provided in this section will involve updating your system’s 
configuration. For help with these tasks, refer to SANPoint Control QuickStart Installation 
and Configuration Guide. 

This section contains the following topics:

“Issues When Viewing HBAs and Hosts” on page 64

“Issues When Viewing Switches” on page 68

“Issues When Viewing Fabrics” on page 72

“Issues When Viewing Other Objects” on page 73

“Issues When Creating or Updating Objects” on page 76

“Issues When Grouping Objects” on page 77

“Issues When Viewing Reports” on page 78
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Issues When Viewing HBAs and Hosts
Issues When Viewing HBAs and Hosts
This section explains how to fix problems related to viewing HBAs and hosts, such as hosts 
not being displayed properly.

Issues When Viewing HBAs and Hosts

Problem Explanation Solution

Nothing is displayed except the 
host to which you are connected

The HBA driver or the firmware 
for the switch to which the 
driver is connected may not be 
supported.

Check VERITAS SANPoint 
Control QuickStart 4.0 Hardware 
and Software Compatibility List to 
make sure the HBA driver and 
the firmware for the switch to 
which the driver is connected 
are fully supported. If 
necessary, upgrade the driver or 
firmware. See your vendor 
documentation.

The SNMP explorer may be 
disabled.

Enable the SNMP explorer. See 
SANPoint Control QuickStart 
Installation and Configuration 
Guide. 

The switch could be down or 
restarting.

Check to make sure the switch 
is running properly. See your 
vendor documentation.

An HBA is not being displayed 
in the VEA Console

In-band discovery may be 
configured and the HBA or 
HBA driver may not support 
the Common Transport (CT) 
protocol.

Disable the Management 
Explorer from using Fibre 
Channel connections via CT.

Note Disabling the 
Management Explorer 
from using Fibre Channel 
connections via CT only 
affects the QuickStart 
Server; DisableCT does 
not affect MGEX running 
in-band on any 
QuickStart Agent.

See SANPoint Control QuickStart 
Installation and Configuration 
Guide. 
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QuickStart Agent hosts are not 
displayed in the VEA Console

The QuickStart Agent hosts 
may not be listed or specified 
correctly in SANPoint Control 
QuickStart.

Make sure the hosts are listed 
correctly, using fully-qualified 
DNS names, dot notation, or 
host name. See SANPoint 
Control QuickStart Installation 
and Configuration Guide. 

The hosts may be listed by IP 
address in SANPoint Control 
QuickStart; however, the hosts 
may be using DHCP. When the 
hosts are rebooted, there is no 
guarantee that they will have 
the same IP address.

If the hosts are listed by IP 
address, give the hosts’ static IP 
addresses. See your vendor 
documentation.

The hosts may be listed by 
fully-qualified domain names. If 
so, it may not be possible for 
SANPoint Control QuickStart to 
resolve those names.

If the hosts are listed by 
fully-qualified domain names, 
make sure they can be resolved 
correctly. See your vendor 
documentation.

The QuickStart Server may not 
be able to communicate with 
hosts inside a firewall. If the 
QuickStart Server itself is 
outside the firewall, ports 161 
and 162 must be enabled.

Enable ports 161 and 162. See 
your vendor documentation.

SANPoint Control QuickStart 
discovered the HBA, but not the 
host

The host may not be running 
the QuickStart Server or the 
QuickStart Agent.

Install the QuickStart Agent on 
the host. See SANPoint Control 
QuickStart Installation and 
Configuration Guide. 

The HBA may not have been 
discovered by the HBA 
Explorer. The Management 
Explorer and SNMP Explorer 
provide limited discovery, 
creating a unidentified adapter 
object for the HBA.

Check the VERITAS SANPoint 
Control QuickStart 4.0 Hardware 
and Software Compatibility List to 
make sure the HBA is fully 
supported. Configure SANPoint 
Control QuickStart to discover 
the HBA. See SANPoint Control 
QuickStart Installation and 
Configuration Guide. 

Issues When Viewing HBAs and Hosts (continued)

Problem Explanation Solution
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A down arrow displays next to 
a host

The down arrow indicates the 
host is disconnected.

If a connected HBA 
(unidentified adapter) is added 
to a host using the Host Wizard, 
the down arrow goes away.

HBAs in the QuickStart Server 
host show up in the SAN 
discovery data store and in the 
VEA Console as unknown 
nodes

The HBA Explorer may be 
disabled on the QuickStart 
Server host. 

Create a host object to enclose 
the unknown HBAs. See 
“Creating, Modifying, and 
Deleting Host Objects” on 
page 37.

The Agent may not be pointing 
to the QuickStart Server.

Make sure the QuickStart Agent 
is configured correctly. See 
SANPoint Control QuickStart 
Installation and Configuration 
Guide. 

SANPoint Control QuickStart is 
receiving inconsistent 
information from the HBA 
driver

The firmware may not have 
been flash-updated to the 
version required by SANPoint 
Control QuickStart. The 
firmware that is supplied from 
the factory does not work with 
the HBA driver that is needed to 
support CT passthru.

To check the correct version, see 
the VERITAS SANPoint Control 
QuickStart 4.0 Hardware and 
Software Compatibility List. To 
flash-update the HBA, see your 
vendor documentation.

An HBA can’t connect to a 
fabric

The HBA may be in Loop mode 
while the switch is in Fabric 
mode. 

Set the HBA to Fabric mode. See 
your vendor documentation.

The HBA may not be able to log 
in to a fabric again after it has 
logged out.

After disconnecting an HBA 
from a switch, then 
reconnecting it, you may have 
to reboot the host. See your 
vendor documentation

An HBA can’t connect to a 
Brocade fabric

Brocade switches that are set to 
QuickLoop mode may prevent 
HBAs from connecting to SAN 
fabrics. 

Set the switch to Fabric mode. 
See your vendor 
documentation.

Issues When Viewing HBAs and Hosts (continued)

Problem Explanation Solution
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An HBA can’t connect to a 
QLogic or JNI fabric

The HBA may not be 
configured to connect to the 
fabric. The default value in the 
HBA configuration file prevents 
the HBA from connecting to the 
fabric.

Configure the HBA to connect 
to the fabric. See your vendor 
documentation.

Issues When Viewing HBAs and Hosts (continued)

Problem Explanation Solution
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Issues When Viewing Switches
This section explains how to fix problems related to viewing switches, such as switches 
not being displayed and switch states being unknown.

Issues When Viewing Switches

Problem Explanation Solution

A switch is not being displayed 
in the VEA Console

The switch may not be 
supported.

Check the VERITAS SANPoint 
Control QuickStart 4.0 Hardware 
and Software Compatibility List to 
make sure the device is 
supported.

The firmware version may be 
incorrect. If the firmware is an 
incorrect version, in-band and 
out-of-band discovery may not 
work.

Check the required firmware 
version in the VERITAS 
SANPoint Control QuickStart 4.0 
Hardware and Software 
Compatibility List. Upgrade the 
firmware if necessary. If 
required by the vendor, reboot 
the device. See your vendor 
documentation.

The switch may be down. Make sure the switch is running 
properly. See your vendor 
documentation.

There may be error conditions 
involving the ports.

Check the ports on the switch to 
see if there are error conditions. 
If there are, resolve them. See 
your vendor documentation.

If you are using out-of-band 
discovery, the switch may not 
be configured for out-of-band 
addressing (IP address, subnet 
mask, and gateway). If so, 
SANPoint Control QuickStart 
can’t discover the switch 
out-of-band.

Configure the switch for 
out-of-band addressing if 
necessary, or use in-band 
discovery. See your vendor 
documentation.

If you are using out-of-band 
discovery, the Ethernet 
connection may be down.

Make sure the connection is up. 
See your vendor 
documentation.
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If using in-band discovery, the 
switch may not be configured 
so that it is accessible through a 
Fibre Channel (FC) connection 
by the host on which the Server 
is installed. An FC connection is 
required for in-band discovery.

Make sure the switch and the 
QuickStart Server host have a 
direct Fibre Channel 
connection, or use out-of-band 
discovery. See your vendor 
documentation.

If using out-of-band discovery, 
the switch may not be accessible 
through IP by the host on which 
the QuickStart Server or 
QuickStart Agent is installed. If 
the switch is isolated on a 
separate subnet, SANPoint 
Control QuickStart can’t resolve 
IP addresses, and as a result, 
can’t discover the switch 
out-of-band.

Note For McDATA, the proxy, 
not the switch, must be 
available.

From the QuickStart Server or 
QuickStart Agent host, try 
pinging the host running the 
application. If this is 
unsuccessful, then there is a 
problem with the network. See 
your vendor documentation.

vxsald may not be running on 
your QuickStart Agents. 

Make sure vxsald is running 
on all of your QuickStart 
Agents. See the description of 
vxsal in SANPoint Control 
QuickStart Installation and 
Configuration Guide. 

A McDATA switch is not being 
displayed in the VEA Console 
using in-band discovery

If you are trying to use in-band 
discovery, in-band CT 
commands (in particular, 
Management Server 
commands) may not be 
enabled. SANPoint Control 
QuickStart in-band discovery 
and zoning commands can’t 
work unless in-band CT 
Management Server commands 
are turned on.

Check to make sure in-band CT 
commands are enabled in the 
EFC Manager (EFCM). Enable 
in-band CT Management Server 
commands if necessary. See 
your vendor documentation.

Issues When Viewing Switches (continued)

Problem Explanation Solution
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The McDATA Open Systems 
Management Server (OSMS) 
license may not be installed. 
OSMS is required for in-band 
discovery.

If necessary, purchase and 
install the OSMS license. See 
your vendor documentation.

The wrong IP address is being 
displayed for a McDATA switch

The IP address may be the 
proxy’s IP address. If the switch 
is attached to a proxy, the 
proxy’s IP address is displayed.

Check to see if the switch has a 
proxy. See your vendor 
documentation.

The Domain ID for a McDATA 
switch keeps changing from one 
value to another

Out-of-band and in-band 
discovery both may be enabled.

Enable only one method of 
discovery. See SANPoint Control 
QuickStart Installation and 
Configuration Guide. 

Free ports are not being 
displayed in the VEA Console

The switch may not report that 
attribute.

Check the vendor 
documentation to see if it 
reports free ports.

The port count is not being 
displayed in the VEA Console

The switch may not report that 
attribute.

Check the vendor 
documentation to see if it 
reports port count.

No interconnect lines are 
displayed between two 
switches in the Topology Map, 
even though the two switches 
are connected to each other

The firmware version may not 
support E-Ports.

Check the required firmware 
version in the VERITAS 
SANPoint Control QuickStart 4.0 
Hardware and Software 
Compatibility List. Upgrade the 
firmware if necessary. See your 
vendor documentation.

The port setting on one or both 
switches may be incorrect. For 
example, one may be set to be 
an F-port.

Set the ports according to 
SANPoint Control QuickStart 
Installation and Configuration 
Guide and the SANPoint Control 
QuickStart Release Notes.

There may be zoning conflicts 
between the switches.

Eliminate zoning conflicts. See 
your vendor documentation.

Issues When Viewing Switches (continued)

Problem Explanation Solution
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The switches may be 
incompatible.

Check the VERITAS SANPoint 
Control QuickStart 4.0 Hardware 
and Software Compatibility List 
and your vendor 
documentation to determine 
whether the switches are 
supported and compatible.

The two switches may be 
configured to have the same 
Domain ID, which prevents 
them from joining a fabric.

Make sure each switch has a 
different Domain ID.

Issues When Viewing Switches (continued)

Problem Explanation Solution
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Issues When Viewing Fabrics
This section explains how to fix problems related to viewing fabrics, such as not being able 
to discover a fabric. 

Issues When Viewing Fabrics

Problem Explanation Solution

SANPoint Control QuickStart 
didn’t discover a fabric

Loop mode may be enabled on 
the HBA.

Enable Fabric mode for your 
HBA to work correctly with 
SANPoint Control QuickStart. 
See your vendor 
documentation.

A SAN fabric was split after 
switch rebooting

The zoning table on the switch 
may have some inconsistencies.

Refresh the switch zoning table. 
See your vendor 
documentation.

The primary switch in the fabric 
is not listed first

The switch display name may 
not be first because the list is 
sorted alphabetically.

None.
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Issues When Viewing Other Objects
This section explains how to fix problems related to viewing other SAN objects, such as 
routers and hubs not being displayed.  

Issues When Viewing Other Objects

Problem Explanation Solution

Deleted objects keep 
reappearing in the VEA Console

The deleted object may be 
discoverable, which means it is 
added to the SAN discovery 
data store again the next time an 
Explorer successfully discovers 
it and the VEA Console is 
refreshed.

This is the expected result for 
discoverable objects. However, 
you can move objects to another 
fabric or filter them.

Objects in the Topology Map or 
the Tree View change 
unexpectedly

spcconfig may have been run 
after SANPoint Control 
QuickStart was already 
installed. If the old 
configuration file (sal.conf) 
was configured manually, the 
new file may not be the same. 
(The old file will have been 
archived.) As a result, you may 
see changes in the Topology 
Map or the Tree View.

Reconfigure the QuickStart 
Server, or archive the new file 
and restore the old file. See 
SANPoint Control QuickStart 
Installation and Configuration 
Guide. 

Objects in the Topology Map or 
the Tree View are not being 
updated 

The QuickStart Agents may not 
be discovering the SAN because 
the QuickStart Server has been 
shut down.

Make sure the QuickStart Server 
is running.

Objects are missing from the 
Tree View

The objects may not have been 
discovered.

Make sure discovery is 
configured correctly for all 
objects. See SANPoint Control 
QuickStart Installation and 
Configuration Guide.  Also, see 
the rest of the topics in this 
section to troubleshoot specific 
devices.

Objects are missing from the 
Topology Map

Filtering may be turned on, 
which can exclude the items 
you want to view.

Turn off filtering. See “Filtering 
in the Topology Map” on 
page 22.
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Devices attached to a Brocade 
switch are missing

The firmware version for the 
devices may be incorrect.

Check the required firmware 
version in the VERITAS 
SANPoint Control QuickStart 4.0 
Hardware and Software 
Compatibility List. Upgrade the 
firmware if necessary. If 
required by the vendor, reboot 
the device. See your vendor 
documentation.

SANPoint Control QuickStart 
discovered incorrect objects 
attached to a Brocade switch

The QuickStart Server may have 
been running when the switch 
was rebooted.

Stop the QuickStart Server, 
reboot the switch, and restart 
the QuickStart Server. See 
SANPoint Control QuickStart 
Installation and Configuration 
Guide. 

The Brocade switch may not be 
able to see the devices.

telnet to the switch and run 
nsShow and switchShow. If 
the correct devices still are not 
discovered, troubleshoot the 
physical connection between 
the switch and the devices. Here 
are some things to try:

◆ Check whether the device is 
powered up.

◆ Find the wire or fibre from 
the device to the switch and 
make sure the LED status is 
solid green.

◆ Move the switch end of the 
wire to a different port.

◆ Replace the wire or fiber.

◆ Diagnose the device itself.

See your vendor 
documentation.

Issues When Viewing Other Objects (continued)

Problem Explanation Solution
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OS handle (device handle) 
status for some devices changes 
frequently

An Emulex HBA may be on the 
same SAN fabric as a QLogic 
HBA. The Emulex HBA 
executes an invalid login 
sequence, which causes the 
QLogic HBA to constantly retry 
port discovery, with 
inconsistent results.

Keep the Emulex HBA and 
QLogic HBA on separate 
fabrics. For more details, see 
your vendor documentation.

Issues When Viewing Other Objects (continued)

Problem Explanation Solution
Appendix A, Troubleshooting 75



Issues When Creating or Updating Objects
Issues When Creating or Updating Objects
This section explains how to fix problems such as not being able to create or delete objects.

Issues When Creating or Updating Objects

Problem Explanation Solution

You can’t create, change, or 
delete objects 

The VEA Console may not be 
able to connect to the Server.

Check the connection and try 
again.

Multiple SAN discovery data 
stores contain conflicting 
information about the same 
objects on the SAN

Multiple QuickStart Servers 
may be trying to discover and 
manage the same fabric. Users 
may be making simultaneous 
and conflicting changes to the 
SAN.

Use only one QuickStart Server 
to discover and manage a SAN 
fabric. For more information 
about installing SANPoint 
Control QuickStart 
components, see SANPoint 
Control QuickStart Installation 
and Configuration Guide. 
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Issues When Grouping Objects
This section explains how to fix problems such as not being able to add an object to a 
storage account or storage group.

Issues When Grouping Objects

Problem Explanation Solution

Can’t add an object to a storage 
account 

The object may already be a 
member of another storage 
account.

Remove the object from the 
other storage account. See 
“Creating, Modifying, and 
Deleting Groups” on page 45.

Can’t add an object to a storage 
group 

The object may already be a 
member of another storage 
group.

Remove the object from the 
other storage group. See 
“Creating, Modifying, and 
Deleting Groups” on page 45.

Can’t add a storage group to 
another storage group 

The second group may be a 
member of the first group. 
SANPoint Control QuickStart 
checks for cyclic dependency.

Remove the second group from 
the first group. See “Creating, 
Modifying, and Deleting 
Groups” on page 45.

Can’t add generic groups to 
storage accounts or storage 
groups 

A storage account may contain 
other storage accounts or 
storage groups, but can’t 
contain generic groups.

A storage group may only 
contain other storage groups. 
A storage group can’t contain 
storage accounts or generic 
groups.

Add storage accounts or storage 
groups to storage accounts. Add 
storage groups to storage 
groups. See “Creating, 
Modifying, and Deleting 
Groups” on page 45.
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Issues When Viewing Reports
This section explains how to fix problems such as reports not being available for groups.

Issues When Viewing Reports

Problem Explanation Solution

The inventory report for a 
specific object type is empty

No objects of that type—such as 
groups or zones—are defined 
on the SAN.

To define a group, see “Using 
Groups to Simplify SAN 
Management” on page 42. To 
define other kinds of objects, see 
“Creating and Modifying SAN 
Objects” on page 29.
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Glossary
addressable unit

Any storage resource in the SAN. Also AddrUnit or AU.

Agent

See “SANPoint Control QuickStart Agent.” 

allocated storage

The portion of an object's storage capacity that has been made available to a lower-level 
entity.  For example, array storage is allocated to a host when OS handles (device handles) 
exist in the host operating system. The device handle provides a name identifying a 
storage resource and the means (driver, system call) to access it.  Contrast with 
“unallocated storage.” 

arbitrated loop

A topology for Fibre Channel networks in which nodes are connected in a single logical 
loop or ring created by tying the transmit lead of one Node Loop Port to the receive lead 
of its downstream neighbor. There are primarily two types of arbitrated loops—public 
loops and private loops. A public loop is attached to a SAN fabric. A private loop is a 
free-standing arbitrated loop with no SAN attachment.

attribute

A property of an object that describes something about the object, such as its World Wide 
Name. In SANPoint Control QuickStart, the number and kind of attributes a SAN object 
possesses depends on what type of object it is. 

available storage

The portion of an object's storage capacity that has not yet been allocated, expressed as a 
quantity (such as 10GB) or as a percentage of capacity.
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bridge

A device that connects and passes packets between two segments of a SAN that use the 
same communications protocol. See also “router.” 

broadcast address

An IP address specified for discovering SANPoint Control QuickStart Servers (hosts 
running the SAN Access Layer) within a subnet. 255.255.255.255 is a special IP address 
that SANPoint Control QuickStart can use to search for QuickStart Servers within a 
subnet without crossing a subnet boundary. 

bundle

A logical grouping consisting of up to 16 physical links. SANPoint Control QuickStart can 
discover and display information about a bundle as if it were a single link. Also port 
bundle.

capacity

The amount of storage an object can allocate or use.

circular layout

A layout option in the Topology Map. This layout arranges SAN objects in circular 
patterns that represent arbitrated loops on the SAN.

claimed storage

LUNs for which a host has created an OS handle (device handle).

cluster

A set of hosts (each termed a node) that share a set of disks and are connected by a set of 
redundant heartbeat networks. Clusters can have from one to 32 member systems, or 
nodes.

Console

See “VERITAS Enterprise Administrator (VEA) Console.” 

data store 

See “SAN discovery data store.” 

Details View

The portion of the VEA Console that displays details about the object highlighted in the 
Tree View. The Details View includes several panes (tabs), each of which provides a 
different form of information.
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device

A collective term for disks, tapes, disk arrays, tape arrays, and any other objects that store 
data. Also storage device.

device handle 

See “OS handle.” 

discovery

The process of finding objects on the SAN and adding information about them to a 
database. In SANPoint Control QuickStart, most discovery is done by the SAN Access 
Layer (SAL), which stores information about SAN objects in the SAN discovery data store. 
See also “explorer.”  See also “SAN discovery data store.” 

disk array

A collection of disks controlled and managed through firmware.

disk device

A re-writeable, randomly addressable data storage device. 

disk group

A collection of disks that share a common configuration. A disk group configuration is a 
set of records containing detailed information on existing VERITAS Volume Manager 
objects (such as disk and volume attributes) and their relationships. Each disk group has 
an administrator-assigned name and an internally defined unique ID. The root disk group 
(rootdg) is a special private disk group that always exists.

enclosure

A method for visually grouping SAN objects in the VEA Console’s Tree View and 
Topology Map. For example, a VEA Console user might choose to represent a JBOD 
visually as an enclosure instead of as one or more separate disks. 

event

A notification that indicates when an action, such as a change in state, has occurred for 
one or more objects on the SAN fabric.

explorer

A software tool that uses a unique methodology to discover information about a 
particular kind of object on the SAN. The SAN Access Layer (SAL) component includes 
several explorers which are used to locate objects on the SAN and discover information 
about them. See also “discovery.” 
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fabric

A group of SAN objects connected by a Fibre Channel (FC) switch. A fabric contains at 
least one FC switch and may also contain zones. 

fan layout

A layout option in the Topology Map. This layout arranges SAN objects in a layout that 
positions the switches at the top of the Topology Map and fans all devices and hosts out at 
a level below the switches in a symmetrical fashion. 

Fibre Channel

A technology for connecting and managing storage networks. A set of standards capable 
of transferring data between ports and through network devices at higher speeds and 
over significantly greater distances than SCSI technology. Fibre Channel supports 
point-to-point, loop, and fabric topologies.

filter

A way of limiting the number of SAN objects represented in the Topology Map. By 
applying a filter, you can focus on any the object that is selected in the Tree View.

firmware

A set of software instructions set permanently in a device’s memory.

GBIC

Gigabit interface converter. A widely used transceiver module for Fibre Channel. A GBIC 
is modular and hot-swappable and can be either copper or optical. 

generic device

A disk or tape device. When generic storage devices are visible to a host running the SAN 
Access Layer, the VEA Console displays the correct object type. 

group

A class or collection of storage objects. You can use groups for a number of different 
purposes such as meeting certain availability and redundancy requirements, or for 
administrative or tracking purposes. Groups can be associated with one or more servers, 
or with a user group (as defined by the operating system). SANPoint Control QuickStart 
supports three different types of groups: generic groups (switches, hosts, storage devices), 
storage groups (storage devices only), and storage account groups (hosts, storage 
devices).
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hard zoning

A fabric zoning method in which a Fibre Channel switch actively blocks access to zone 
members from any objects outside the zone. Because the active blocking takes place at the 
level of ports on the switch, hard zoning is also referred to as switch port zoning. In hard 
zoning, each switch uses a routing table to determine whether data is allowed to flow 
across a connection. See also “soft zoning.” 

HBA

Host bus adapter. An interface between a server or workstation bus and a Fibre Channel 
network.

hierarchical layout

The default layout option in the Topology Map. This layout stratifies the Topology Map 
according to object type, with hosts at the top layer, switches below them, and devices of 
all kinds below the switches. 

host

A computer system to which storage devices and file servers are attached. The SANPoint 
Control QuickStart Server and the SANPoint Control QuickStart Agent reside on hosts.

host bus adapter

See “HBA.” 

hub

A common connection point for devices in the SAN. The hub may be unmanaged, 
IP-managed, or FC-managed. An unmanaged hub is passive in the sense that it serves 
simply as a conduit for data, moving the data from one SAN device to another. 
IP-managed and FC-managed hubs are intelligent, containing features an administrator 
can use to monitor the traffic passing through the hub and configure each port in the hub.

in-band

A type of Fibre Channel management protocol. The most prevalent in-band protocol over 
Fibre Channel is SCSI Enclosure Services (SES). Contrast with “out-of-band.” 

iSCSI router

A storage router implementing the Internet Small Computer Systems Interface (iSCSI) 
protocol (SCSI over IP) to extend access of a Fibre Channel fabric and attached storage 
devices to IP servers. Currently, SANPoint Control QuickStart discovers only the Cisco SN 
5420 iSCSI router.
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JBOD

Acronym for “just a bunch of disks.” A cabinet of disks.

logical unit number

See “LUN.” 

logical volume

A simple volume that resides on an extended partition on a basic disk and is limited to the 
space within the extended partitions. A logical volume can be formatted and assigned a 
drive letter, and it can be subdivided into logical drives. See also “LUN.” 

LUN

Acronym for “logical unit number.” A unique and discrete addressable unit or logical 
volume that may reside inside one or more simple or array storage devices. LUNs are 
exposed to the outside world through an addressing scheme presented to the host as SCSI 
LUN numbers. Each LUN has a unique OS handle (device handle) and represents a logical 
volume.

master server

The NetBackup server that provides administration and control for backups and restores 
for all clients and servers in a master and media server cluster. NetBackup BusinesServer 
supports only a single server, and it is the master. See also “media server.”  See also 
“VERITAS NetBackup.” 

media server

A NetBackup server that provides storage within a master and media server cluster. The 
master can also be a media server. A media server that is not the master is called a remote 
media server. NetBackup BusinesServer does not support remote media servers. See also 
“master server.”  See also “VERITAS NetBackup.” 

NetBackup

See “VERITAS NetBackup.” 

network layout

A layout option in the Topology Map. This layout emphasizes the switches on your SAN 
by displaying them centrally among the various other objects to which they connect.
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object

A single, unique addressable entity on a SAN. It is possible for objects to be present within 
objects. For example, while a tape array is an object, each individual tape drive within the 
array is also an object. A host is an object, and the HBA inside the host is also an object. 
Each object has one or more attributes and can be a member of one or more zones. 

object tree

A dynamic, hierarchical display of VERITAS Volume Manager objects and other objects 
on the SAN. Each node in the tree represents a group of objects of the same type.

OS handle

The name the operating system uses to identify a storage resource (known as an 
addressable unit or LUN), and the correct means (driver, system call) to access it. Also 
device handle.

out-of-band

A type of communication protocol other than the Fibre Channel management protocol, 
such as SNMP or a vendor-specific proprietary protocol. Contrast with “in-band.” 

physical fabric

The physical components of a fabric, including all switches and all other SAN objects. You 
can configure one or more virtual fabrics—each one isolated from the others—based on 
the hardware components in the physical fabric.

port

A connection through which a device is attached to an I/O bus or to the SAN, or the 
representation of this physical connection to the link hardware.

port bundle

See “bundle.” 

provisioning

The set of activities that allocate storage to hosts and host applications.  Examples of 
provisioning activities include creating LUNs in an array, setting up zoning between a 
host and an array, and giving the server access to the storage.

QuickStart

See “SANPoint Control QuickStart.”  
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Reporter

See “SANPoint Control QuickStart Reporter.” 

robotic library

A collection of tapes controlled and managed through firmware. 

router

A device that connects two segments of a SAN and determines the optimal path along 
which network traffic should be forwarded. Also gateway. See also “bridge.” 

SAL 

See “SAN Access Layer (SAL).” 

SAL Remote

See “SANPoint Control QuickStart Agent.” 

SAN

See “storage area network (SAN).” 

SAN Access Layer (SAL)

A component of the SANPoint Control QuickStart Server that performs discovery and 
access control. By discovering objects and the relationship of these objects to each other, 
the SAL maintains a real-time topology of the SAN. The SAL also interacts directly with 
switches and storage arrays to control access to storage resources. The SAL agent—part of 
the SAL—communicates with client applications by sending and receiving XML messages 
by means of the http protocol.

SAN discovery data store

The database containing the names and attributes of all objects discovered and 
maintained by the SAN Access Layer (SAL). This database also contains information 
about user-defined objects and their attributes.

SANPoint Control QuickStart 

A VERITAS software product designed to maximize the return on an enterprise’s SAN 
technology investment by helping the SAN administrator make the SAN operate as 
effectively as possible. SANPoint Control QuickStart consists of three major components: 
the QuickStart Server, the QuickStart Agent, and the VEA Console.
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SANPoint Control QuickStart Agent 

A SANPoint Control QuickStart component that assists the SANPoint Control QuickStart 
Server in discovering the entire SAN. The QuickStart Agent consists of several SAN 
explorers that are also used by the QuickStart Server, including the Cisco MDS explorer, 
the Management explorer, the SNMP explorer, and the HBA explorer. Although the 
QuickStart Agent uses a modified form of the same SAN Access Layer (SAL) process used 
in the QuickStart Server, it is not a server itself.

SANPoint Control QuickStart Reporter

A component of the VEA Console with which you can view inventory reports for the 
objects on your SAN. The Reporter can be invoked at any time during a VEA Console 
session.

SANPoint Control QuickStart Server

The portion of SANPoint Control QuickStart that resides on the primary host. It consists 
of the SAN Access Layer (SAL) and the SAN discovery data store.

SCSI

Small Computer Systems Interface. A hardware interface that allows for the connection of 
multiple peripheral devices to a single expansion board that plugs into the computer. The 
interface is widely used to connect personal computers to peripheral devices such as disk 
and media drives.

SCSI bridge

A bi-directional routing device that provides for data transfers between Fibre Channel 
(FC) SANs and SCSI devices.

SCSI bus

The communication pathway between a SCSI host adapter card and target SCSI devices. 
Physically, the bus begins at one end of a SCSI cable at the host adapter card and ends at 
the other end of the cable at the target device.

SCSI disk

A storage device (fixed disk) attached to a SCSI bus.

SCSI LUN

A division within a group of SCSI devices that identifies a sub-device. See also “LUN.” 
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SCSI tape

A tape drive attached to a SCSI bus. Examples of SCSI tape drives include: quarter-inch 
cartridge (QIC); digital audio tape (DDS DAT); 8mm tape; and digital linear tape (DLT).

SCSI target

A device in a SCSI bus that receives communication from a SCSI initiator (typically a SCSI 
host adapter card).

Server

See “SANPoint Control QuickStart Server.” 

slot

An opening in a computer or other network device into which a printed circuit board can 
be inserted, adding capability to the device. Also expansion slot.

soft zoning

A fabric zoning method that filters the visibility of objects on the SAN so that an object can 
only see other objects that share at least one zone membership with it. Unlike hard zoning, 
soft zoning is not enforced at the switches themselves. See also “hard zoning.” 

storage account

A type of storage group containing one or more host objects and all the storage that the 
administrator assigns to the hosts. The storage account is used to keep track of the storage 
resources provisioned for hosts on a SAN. A storage account may contain other storage 
accounts or storage groups, but it cannot contain generic groups. 

storage area network (SAN)

A network linking servers or workstations to devices, typically over Fibre Channel, a 
versatile, high-speed transport. The storage area network (SAN) model places storage on 
its own dedicated network, removing data storage from both the server-to-disk SCSI bus 
and the main user network. The SAN includes one or more hosts that provide a point of 
interface with LAN users, as well as (in the case of large SANs) one or more fabric 
switches and SAN hubs to accommodate a large number of storage devices.

storage device

See “device.” 

storage group

See “group.” 
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subnet

A portion of a SAN typically consisting of all machines in one locale, in one building, or 
on the same local area network (LAN). Internet Request for Comments 950 provides the 
standard procedure for creating and identifying subnets. 

subnet mask

A 32-bit mask that identifies the portions of an IP address to be used for locating 
addresses in a subnetwork.

switch

A network device to which nodes attach and which provides high-speed switching of 
node connections via link-level addressing. 

tape device

A storage device that writes data to tape. SANPoint Control QuickStart identifies a tape 
drive, tape transport, and tape arrays as a tape device. 

tape mark

A mark that is recorded between backup images on a tape.

topology

The physical or logical arrangement of objects on the SAN and the connections between 
them. 

Topology Map

A graphical representation of the physical or logical arrangement of SAN devices. The 
Topology Map provides a visual representation of the objects on the SAN and the 
connections between them. In SANPoint Control QuickStart, the Topology Map displays 
when the Topology tab is selected in the Details View.

Tree View

The left portion of the VEA Console in which a directory tree of SAN objects is displayed.

unallocated storage

Storage for which OS handles (device handles) do not exist in the host operating system.  
Contrast with “allocated storage.” 
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unidentified adapter

An HBA or storage device that has logged into a Fibre Channel switch and about which 
SANPoint Control QuickStart has no information. For HBAs, this can occur when the 
SAN runs an unsupported HBA card or driver version, there is no remote SAN Access 
Layer (SAL) running on the host attached to the HBA, or the SANPoint Control 
QuickStart Server is not configured to communicate with the remote SAL. For storage 
devices, this can occur when no LUNs are visible to one of the hosts running the SAL (for 
example, due to zoning).

unused storage

Storage that does not have data written to it. Contrast with “used storage.” 

used storage

The portion of storage allocated to a file system or database to which data has been 
written, expressed as a quantity (such as 10GB). Contrast with “unused storage.” 

VEA

See “VERITAS Enterprise Administrator (VEA) Console” and “VERITAS Enterprise 
Administrator (VEA) Server.” 

VERITAS Cluster Server

An open systems clustering solution designed to eliminate planned and unplanned 
downtime, simplify server consolidation, and allow the effective management of a wide 
range of applications in multiplatform environments.

VERITAS Cluster Server cluster

A cluster consisting of multiple systems connected in various combinations to shared 
storage devices. VERITAS Cluster Server monitors and controls applications running in 
the cluster and can restart applications in response to a variety of hardware or software 
faults. A cluster is defined as all systems with the same cluster identification and 
connected via a set of redundant heartbeat networks. Clusters can have from one to 32 
member systems, or nodes.

VERITAS Cluster Server service group

A set of resources working together to provide application services to clients. For 
example, a Web application service group might consist of: disk groups on which the Web 
pages to be served are stored; a volume built in the disk group; a file system using the 
volume; a database whose table spaces are files and whose rows contain page pointers; 
the network interface card or cards used to export the Web service; one or more IP 
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addresses associated with the network card(s); the application program and associated 
code libraries. VERITAS Cluster Server performs administrative operations on resources, 
including starting, stopping, restarting and monitoring at the service group level. 

VERITAS Enterprise Administrator (VEA) Console

A graphical user interface that displays information from the SAN Access Layer (SAL) 
and other SANPoint Control QuickStart Server components. The VEA Console provides a 
central point to view and manage objects on the SAN.

VERITAS Enterprise Administrator (VEA) Server

A separate middleware server used in SANPoint Control QuickStart to display the VEA 
Console and by the SAN Access Layer (SAL) and other processes to provide client-server 
communication. The VEA infrastructure enables software components to share 
information about objects, manage those objects, and effect change on those objects. Also 
VEA object bus.

VERITAS NetBackup

A VERITAS product family designed to provide a fast, reliable backup and recovery 
solution for environments ranging from terabytes to petabytes in size. The term NetBackup 
is used to refer to either of two products that interact with SANPoint Control QuickStart: 
VERITAS NetBackup DataCenter and VERITAS NetBackup BusinesServer. 

VERITAS Volume Manager

A VERITAS software product installed on storage clients that enables management of 
physical disks as logical devices. Volume Manager enhances data storage management by 
controlling space allocation, performance, data availability, device installation, and 
system monitoring of private and shared systems.

virtual fabric

A grouping of switches and other objects that constitute a hardware-based, isolated 
environment within a physical fabric. This isolation of SAN objects within a single 
physical fabric is intended to enable more efficient use of the SAN, especially in terms of 
availability and scalability. Also virtual SAN.

virtual hub

A set of switch ports on the same fabric that are placed into a logical grouping and use an 
address spoofing mechanism to emulate a Fibre Channel Arbitrated Loop (FC-AL) hub. A 
virtual hub can be comprised of all the ports on a single switch or several ports on one or 
more switches. It is used primarily to allow older loop-only devices to be attached to a 
switched fabric and be accessible as though they were fabric capable.
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virtual SAN

See “virtual fabric.” 

virtualization

Representing one or more objects, services, or functions as a single abstract entity so that 
they can be managed or acted on collectively. An example of virtualization is the creation 
of a virtual fabric from a switch and associated SAN objects as a means of controlling 
access and increasing scalability in the SAN.

visible storage

Allocated LUNs that are zoned to a host.

volume

A virtual disk, representing an addressable range of disk blocks used by applications such 
as file systems or databases. A volume is a collection of from one to 32 plexes.

Volume Manager

See “VERITAS Volume Manager.” 

World Wide Name (WWN)

A registered, 64-bit, unique identifier that is assigned to nodes and ports.

zone

A named subset of nodes and ports (zone members) on a single fabric. Fabrics secure data 
from unwanted access by restricting the interconnectivity between nodes belonging to 
different zones. 

zone alias

A symbolic name assigned to a device or group of devices on a SAN fabric. Zone aliases 
are used to assign a familiar name to a device or to group multiple devices into a single 
name.

zone member

An object that belongs to a zone. An object can belong to more than one zone.
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